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1) Uruchom program Cinema4D. Aby poprawnie zrekonstruowac objekt
(uwzgledniajac proporcje, ksztalt, itp) wygodnie jest postuzy€ sie jego rysunkami
technicznymi w rzutach (przéd, géra, bok, przekrojami,....najlepiej
zwymiarowanymi, lub chociazby z podang skala). Jezeli nimi nie dysponujemy -
warto rekonstruowany objekt sfotografowac (z wczesniej wymienionych kierunkow
- korzystajac najlepiej z objektywu dlugoogniskowego i umieszczajac na kazdym
zdjeciu obok interesujacego Cie objektu - element pozwalajacy ujednolici€¢ skale
zdje€ - np: linijke "calowke"). Nastepnie tak przygotowane materiaty nalezy
umiescic w odpowiednich widokach w Cinemie (czyli np: zdjecie z gory w widoku
ZX itd.). W tym celu w oknie interesujacego Cie widoku wybierz z menu File ->
Configure. Pojawi sie okno Configure Viewport. Spbjrz w dziat Backround.
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2) W celu zataczenia w widoku zdjecia zkliknij Show Picture. Przycisk
z trojkropkiem pozwoli Ci wskaza¢€ potrzebny do umieszczenia plik bitmapowy.
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3) Pod nim znajduja sie pola Horizontal Size i Vertical Size - sterujgce rozmiarem
wyswietlanego obrazu. Wpisz tam takie wartosci, ktore beda zgodne z proporcjami
bokow zataczanej bitmapy (aby obraz sie nie zdeformowat) i przemnozone przez
wspotczynnik powiekszenia (czyli skale jakg chcesz wybra¢ dla rekonstruowanego
objektu).
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4) Jezeli potozenie bitmapy nie jest zadawalajace - popraw je zmieniajac wartosci
w polach Horizontal Offset i Vertical Offset.
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5) Kiedy rozmiescisz juz w widokach roboczych odpowiednie pliki z konstrukcja
objektu - zacznij rysowac krzywe opisujace profile przekroju kadtuba. Rysuj tylko
lewa potowe. Najlepiej rysyj wszystkie krzywe w jednym kierunku (utatwi Ci to
prace - nie bedziesz potem musiat odwracac kierunku przebiegu krzywej) ja
rysowatem je od dolnego punktu, w prawo w gore itd.

ools  Selection  Struc
L0 Wyl Obje |
. Polygon Object

Primitive k

Spline Object

/SDDﬂPrimitive o[ 5
~ . R-%nlin




6) Warto nowopowstajacym krzywym od razu nadawac czytelne nazwy okreslajace
ich miejsce w hierarchi (w celu zmiany nazwy objektu - kliknij dwukrotnie w jego
nazwe w palecie Objects).

Dodaj do kompozyciji Loft NURBS.
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7) Powrzucaj do niego narysowane krzywe profili kadtuba zachowujac ich
kolejnosc.

8) Korzystajac z narzedzia do pracy na objektach i do ich przemieszczania,
pracujac na widoku YX i YZ ustaw je w rzedzie w odpowiednich dystansach od
siebie (zgodnie z konstrukcja wyswietlang z zatgczonych bitmap). Otwarte konce
krzywych powinny dotykac osi Y.




9) Uzyskany w ten sposob objekt powinien wygladac mniej wiecej tak jak na
obrazku ponizej. Zwro¢ uwage, ze ksztatt - nie jest raczej doktadnie tym co chciates
uzyskac. Pora na poprawki.
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10) Najpierw korzystajac z narzedzia do punktow weztowych i narzedzia do
zaznaczania - zpozycjonuj wszystkie poczatkowe i koncowe punkty krzywych na
wartosci Y = 0. Najlepiej jest to zrobic wybierajac kolejne punkty i wpisujac im taka
wartos¢ w odpowienim polu w palecie Coordinates. Pamietaj by w palecie
Coordinates byt wybrany tryb World.

Nadal jednak ksztatt kadtuba jest niezadawalajacy. Wynika to rowniez z tego faktu
Ze poszczegolne krzywe maja rozng ilos¢ punktow weztowych - powoduje to
niechciane deformacje w ksztatcie kadtuba.
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11) Mozna to zniwelowa¢ dodajac wiecej punktbw weztowych na kolejnych
krzywych (ideatem jest sytuacja gdy kazda z krzywych w Lofcie ma takg samg ilosc
punktow). Pozostajac w trybie zmian na punktach...

12) Dodaj na krzywych kolejne punkty korzystajac z narzedzia Add Points.
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13) Nadal jednak jest istotna roznica pomiedzy ksztattem oryginatu (czarna linia),
a uzyskana rekonstrukcja (biata linia). Teraz przesuwajac (w plaszczyznie YX)
istniejace punkty weztowe (istniejacych krzywych), oraz rysujac nowe krzywe

i dodajac je w odpowiednich miejscach w hierarhii LoOftNURBsa - popraw ksztatt
kadtuba. Rozpoczotes od budowania kadtuba, na podstawie kilkunastu profili nie
obejmujacych miedzy innymi ksztattu owiewki kabiny pilota, czy duzej czesci
ogona. O ile owiewke mozna zrobi¢ w osobnym elemencie, to ogon trzeba
bezwzglednie zrekonstruowac w tej bryle zrekonstruowac.

Pamietaj, ze poprawki mozna by robi¢ przy kazdym modelu w nieskonczonosc
(dysponujac odpowiednio precyzyjnym materiatem zrodtowym).

Dlatego musisz przyjac jakas skale precyzji i szczegolowosci - docelowg dla
modelu. Istotne elementy mosisz zbudowac. Drobne detale naniesiesz na ksztatt
kadluba (skrzydel itd.) przy uzyciu tekstur z Bumpem i Displacementem.
Pamietaj, ze detale nad ktorymi mogtbys sie bardzo napracowac - sg nieistotne
(z punktu widzenia odbiorcy grafiki czy animaciji) - jezeli ze wzgledu na swoja skale
i umiejscowienie nie pozostawig po sobie sladu na finalnym renderingu.




14) Poniewaz owiewke kabiny bedzie stanowit osobny element - powinno sie
obnizy¢ w tej czesci obrys kadtuba, zeby nie wystawat on ze szkta.
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15) W celu odtworzenia czesci ogonowej, skopiowatem kilka istniejacych w Lofcie
krzywych, wkleitem do kompozycji, a nastepnie dorzucitem do Lofta. Umiescitem
w jego hierarhii i przesuwatem, skalowatem, jak i dokonywatem korekty na
punktach weztowych - az do uzyskania rekonstrukgciji tej czesci samolotu.
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16) W sytuacji gdy trudno jest dojs¢ do tadu z zaczepami korekcyjnymi (wasami)
punktow weztowych. Pewnym rozwigzaniem jest pozbawienie ich tych zaczepow
i ponowne mechaniczne nadanie (Structure -> Edit Spline i najpierw Hard
Interpolation, a potem Soft Interpolation).
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17) Skoro w tej chwili posiadasz mniej lub bardziej dopracowane pol kadluba -
warto z niego stworzyc calosc. Dodaj do kompozycji Objects -> Modeling ->
Symmetry. Nastepnie wrzu¢ Loft NURBS do Symmetry (powstat w tym momencie
kompletny kadtub - gdyz druga potbwka zostata wygenerowana symetrycznie).
Zmien nazwe objektu Symmetry na "kadlub".
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18) Czas wykonac owiewke kabiny pilota. Positkujac sie planami samolotu -
narysuj serie krzywych odwzorowywujacych przebieg szyby owieki.
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19) Dodaj do kompozyciji objekt Loft NURBS. Umies¢ w nim narysowane
w poprzednim kroku krzywe.
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20) Powstata bryla moze oczywiscie wymagac poprawek. Najwygodniej bedzie
uczynic je przemieszczajac punkty weztowe poszczegolnych krzywych.
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21) Zmien nazwe Loft NURBS na "kokpit-szklo".
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22) Podobnie jak z kadtubem - dodaj do kompozycji objekt Symmetry, umiesc
w nim "kokpit-szklo". Zmien nazwe z Symmetry na "owiewka".
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23) Teraz zajmiesz sie skrzydtem. Positkujac sie planami samolotu - narysuj serie
krzywych odwzorowywujacych profile ptata.
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24) Dodaj do kompozycji Loft NURBS. Umies¢ w nim krzywe profili ptata i dokonaj
ewentualnych niezbednych poprawek. Zmien jego nazwe na "lewy-plat".
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25) Jak na razie Twoj samolot ma tylko jedno skrzydto. Dodaj do kompozycji objekt
Symmetry.

Objicts

26) Umiesc "lewy-plat" w Symmetry. Zmien nazwe Symmetry na "skrzydla".

27) Teraz zajmiesz sie czescig ogonowg samolotu. Narysuj krzywe odwzorowujace
profile statecznika.




28) Zwrb¢ uwage, ze statecznik podparty jest zastrzatem, ktory trzeba bedzie
wykonac w pozniejszym etapie.
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30) ...i umies¢ w nim w odpowiedniej kolejnosci krzywe odwzorowujace profile
statecznika. Zmien nazwe z Loft NURBS na "statecznik-plat".




31 Dodaj do kompozycji Objects -> Modeling -> Symmetry. Nastepnie wrzuc
"statecznik-plat" do Symmetry. Zmien nazwe objektu Symmetry na "stateczniki".
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32) Zwrot uwage, ze uzyskany statecznik nie jest kompletny, brakuje mu zastrzatu
(oznaczony na czerwono).
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34) Przejdz do trybu pracy ze Sciankami...




35) Nastepnie zaznaczaj je i wyttaczaj narzedziem Structure -> Extrude, az do
uzyskania tak wygladajacej bryty.

Structure

Extrude

36) Dodaj do kompozycji Objekt HyperNURBS i umies¢ w nim Cube.

" HyperNUREBS

37) Efekt Twojego dziatania powinien wyglada¢ mnie wiecej tak.




38) Przejdz do pracy na catych elementach i positkujac sie planami
konstrukcyjnymi samolotu - przesuwajac, obracajac i skalujac umiesc zastrzat
we wiasciwym miejscu.
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39) Nie wyglada on zapewne jeszcze w petni zadawalajgco.
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40) Teraz pracujac na punktach, liniach i ptaszczyznach objektu Cube - popraw
krztatt zastrzatu, az do formy Cie zadawalajace;j.




41) Zmien nazwe z HyperNURBS na "zastrzal".

42) Dodaj do kompozycji operacje Symmetry i umies¢ w niej "zastrzal".
Zmien nazwe z Symmetry na "zastrzaly".
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43) Teraz zbudujesz podwozie samolotu. Narysuj najpierw krzywe bedace
profillami przekroju jednej z przednich goleni.
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44) Dodaj do kompozycji objeky Loft NURBS i umies¢ w nim te profile.
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45) Twoj samolot powinien teraz wygladac tak jak na obrazku ponizej. Zmien
nazwe Loft NURBS na "golen".

46) Teraz narysuj krzywymi profile kotpaka, opony i kota...




47) Dodaj do kompozycji trzy objekty Lathe NURB i wrzu¢ do nich Sciezki. Nazwij je
odpowiednio.
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48) Nastepnie zaznacz je razem (z wcisnietym klawiszem Shift) i zgrupuj
(Object -> Group Objects). Nowo powstatg grupe nazwij "kolo".
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49) Umiesc koto na wtasciwym miejscu.




50) Zgrupuj objekty "kolo" i "golen". Nazwij te grupe "kolo-i-golen".
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51) Dodaj do kompozycji objekt Symmetry i umies¢ w nim grupe "kolo-i-golen".
Zmien nazwe Symmetry na "podwozie".
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52) W wyniku tych operacji samolot powinien wygladac jak na obrazku ponizej.




53) Narysuj teraz krzywa odpowiadajaca ogolnemu przekrojowi topaty Smigta.
Dodaj do kompozycji objekt Extrude NURBS
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54) Wrzu€ utworzong krzywg do Extrude NURBS. Ustaw odpowiednie parametry
wyttoczenia (dystans i kierunek). Dodaj do kompozycji operacje FFD.

Deformation kL%

55) Zgrupuj Extrude NURBSa i FFD. Ustal potozenie i wielkos¢ FFD tak by
doktadnie na wysokos¢ obejmowata ona Extrude NURBSa. Nastepnie zaznacz
FFD i przejdz do trybu pracy na punktach. Przemieszczaj punktu deformera FFD tak
by uzyskac odpowiedni profil topaty Smigta.

56) Pamietaj by w opcjach Extrude NURBSa byta ustawiona wartos¢ Subdivision
wieksza niz 1 (poeksperymentuj az do uzyskania optymalnej precyzji ksztattu).




57) Umiesc topate Smigta w ptaszczyznie poziomej tak jakby oS Y miat stac sie
piasta smigta. Dodaj do kompozyciji Array operacje (Object -> Modeling -> Array)...

58) ...oraz objekt Null Object. Umiesc "lopata" w Null Object.
I:Itl__||;:'|_:f:;: A aelect

Null Object

59) Nastepnie umiesc Null Object w Array-u. Powstato kilka roztozonych koliscie
kopii topat $migta - zeby byto ich tyle ile trzeba i tam gdzie trzeba, zaznacz objekt
Array i w palecie Attributes zmien parametry Radius na 0 (kopie objektu nie bedg
rozsuwane) i Copies na 2 (potrzebyjemy 3 topaty Smigta, mamy juz jedna wiec
potrzebne sg jeszcze 2).




60) Efekt powinien wyglada¢ podobnie jak na obrazku ponizej.

61) Zmien nazwe z Array na "lopaty".
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64) Wrzut krzywa do objektu Lathe NURBS - i powinienes$ mie¢ gotowe $migto.

65) Nazwij Lathe NURBS 'kolpak".
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67) Umiesc "smiglo" we wiasciwym miejscu na makiecie samolotu.




68) Nastepnie dla porzadku zgrupuj wszystkie elementy samolotu...
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69) ...uzyskana grupe nazwij "samolot-zlin".

W ten sposob uzyskates ogolng makiete - mozesz nad nig dalej pracowact
uszczegutawiajac konstrukcje o mnostwo detali (poczawszy od antenek, az po
przod silnika, ktory powinien by¢ widoczny za kotpakiem smigta).
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